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The entry deadline for the 2020
Tennessee State Press Contests is
Friday, Feb. 21. Once again, the
Contests will utilize the BetterBNC
online contests entry and judging
platform.
The categories are the same as
they were in 2019. Entries will be
submitted as PDFs in all but three
categories. Those remaining in
print are Make-Up and Appearance,
Best Special Issue or Section, and
Sunday Editions.
The entry fee increased to $10
per entry. Part of the fee will
provide a $25 gift card for each
TPA member that completes
the judging assignments for our
reciprocal judging partner in
2020 and the $1 increase will go
toward a website showcasing the
winning work.
The divisions for the contests
are calculated on total weekly paid
circulation. They are as follows:
• Division One: Combined weekly total circulation of 5,000 or less
• Division Two: Combined weekly total circulation of 5,001-15,000
• Division Three: Combined
weekly total circulation of 15,00150,000

TPA file photo

First-place winners in the 2019 TPA State Press Contests show off their
hardware at the 2019 TPA Summer Convention held in Chattanooga in
July 2019.
• Division Four: Combined
weekly total circulation of 50,001200,000
• Division Five: Combined weekly total circulation of 200,001-plus.
The complete contests general
rules and link to entry portal will
be available at www.tnpress.com.
Please call TPA at (865) 584-5761,
ext. 105 with any questions.
UT has partnered with TPA
to co-sponsor the contests since
1940. UT will provide the winners’
plaques and certificates and coordinate the awards presentation scheduled for TPA Summer Convention

on Friday, June 19 in Pigeon Forge.
TPA will need judges to meet
obligations to its reciprocal judging
partner in April. If your newspaper
enters the TPA contest, we ask that
you provide a judge.

Ad/Circ Ideas Contest
Plan now to enter the 2020 Ideas
Contest, Tennessee Press Association’s contest for advertising and
circulation ideas.
Entries will be submitted as PDFs
online. The deadline is Friday, Feb.
28. There are no changes or additions to the categories for 2020.

Why America needs newspapers
The newspaper business didn’t
get off to a good start in America.
Publick Occurrences Both Foreign
and Domestick, the first real newspaper in America, was supposed to
be a weekly, but it lasted exactly one
issue. It was shut down by the colonial government, in part because it
published speculation about the king
of France having intimate relations
with his daughter-in-law. I assume
this came from confidential sources.
I share this ancient account
because at a time when many are
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KEN PAULSON
writing the obituary of America’s
newspapers, it’s helpful to remember that things have rarely been
rosy for those who challenge the
powerful, publish the truth and look

out for the American people.
• Despite a newly adopted First
Amendment, President John Adams
used the Alien and Sedition Act to
target critics of his administration,
including newspaper editors. By the
end of his term, America had come
to its senses, deciding that Freedom
of the Press was real.
• Those fighting for equality for
women and the end of slavery couSee PAULSON Page 3

Fees are $6 per entry. Proceeds
support the educational programming for the advertising and
circulation groups at the convention.
First through third places are
awarded in five divisions of each
category, and there is an overall
Best of Show Award. The contest has 29 categories and five
divisions based on circulation.
Awards will be presented during
the TPA Summer Convention on
June 19 in Pigeon Forge.
The divisions are as follows:
• (N-1) Non-daily with a total
circulation less than 5,000
• (N-2) Non-daily with a total
circulation of 5,000 or above
• (D-1) Daily with a total circulation less than 150,000
• (D-2) Daily with a total circulation of 15,000 or above.

Revised Schedule for
2020 TPA Winter Convention
Wednesday, Feb. 12
10:00 a.m. TPS Board of
Directors
1:00 p.m. TPA Government
Affairs Committee Meeting
2:00 p.m. TPA Board of
Directors Meeting & Concurrent
Business Session
3:30 p.m. TPA Foundation
Board of Trustees Meeting
5:00 p.m. Opening Reception
(all state legislators are invited)
7:00 p.m. Dinner on one’s own
Thursday, Feb. 13
7:45 a.m. Breakfast: Public
Notices
9:00 a.m. Address by Gov. Bill
Lee
9:30 a.m. Uncovering the Police
10:30 a.m. Vanderbilt Poll
11:00 a.m. Lt. Gov. Randy
McNally and Speaker of the
House Cameron Sexton
Noon Luncheon address by
Ken Paulson
1:45 p.m. Convention adjourns
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Yoda gives his take (sort of)
on the newspaper industry
The new year is off to a quick
start, and with that comes a burst of
optimism. We made it through another 365 days! Now, with a quick
swipe to the 2020 calendar, we are
energized about new beginnings
and the promise and possibilities
this new year offers. It’s a good time
to take stock of where we are and
where we want to be.
Laying the groundwork for a
successful 2020 means assessing
how our newsrooms, sales teams
and customer service/circulation
departments fared last year. Of
course, laying the groundwork for a
future in this industry is daunting.
In Episode V of the Star Wars saga,
“The Empire Strikes Back,” which
was in theaters more than 35 years
ago, Jedi master Yoda says, “Difficult to see. Always in motion is the
future.” He could have been talking
about the newspaper industry.
Nonetheless, our future is in our
hands (well, mostly). Getting started
on a solid 2020 begins with a look
at 2019’s successes and stumbles
before they are a distant memory:
• What worked? Do you know
why?
• What didn’t perform as expected? Do you know why?

Looking ahead, consider:
• What is holding you back?
• Is there specific training some
of your staff need but you haven’t
found it, or found it at an affordable
price?
• Are there specific challenges
you need help with?
This is a great opportunity for
you to express that need to the Tennessee Press Association because
the TPA can help with training and
networking. We need to hear from
you.
One overlooked assessment
is what you can stop doing. The
financial reality of our industry has
meant all teams are doing more
with less. However, a thorough
evaluation of what you do, why
you do it and for whom you are doing it might lead to some insights
about what we can live without.
Sometimes, we do things out of
habit or simply because we’ve been
doing them for years. But when we
stop and reassess, we realize that
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of our professional organization also
needs our time and energy.

CHRIS VASS

I hope most of you will be in
Nashville next month for our Winter Convention (early registration
discounts are available until Jan.
17; final registration deadline is
Feb. 7). Note that we are eager for
students at the collegiate journalism programs to participate. TPA is
offering 40 scholarships. (Contact
Robyn Gentile at the TPA office at
865-584-5761).
There is plenty on deck at the
convention, including our legislative reception on Feb. 12. This is
an opportunity for all of us to talk
to our legislators about our issues
(and there are several this year)
related to open records, public
meetings, access, transparency, etc.
These types of discussions never
end; new issues are always showing up, ripe for debate. A strong
turnout for this reception and our
convention signals to lawmakers
that we are united and committed.
On the 13th, we will have a chance
to hear from Gov. Bill Lee, Lt. Gov.
Randy McNally and House Speaker
Cameron Sexton. We will get a
peek at some Vanderbilt polling
data and hear from attorney Rick
Hollow as well as veteran newspaper experts Jack McElroy and Ken
Paulson. It’s a dynamic program
with presentations sure to spark
thoughtful discussion and perhaps
plant some seeds for ideas to take
home, issues to follow up on and
stories to pursue.
Twenty twenty will most certainly be a year that will push us, test
us and hopefully reward us. Our
success — and survival — requires
our commitment to do whatever we
can to meet our audiences’ needs:
with news only we can provide,
with superior customer service and
with a results-focused sales effort.
Our readers are counting on us. Or
as Yoda so succinctly said: “Do. Or
do not. There is no try.”

task might no longer be important.
If you ask why something is being
done and the answer is, “Because
we’ve always done it that way,” you
probably need to rethink the task.
For example, for the past 20
years at the Chattanooga Times
Free Press, a designer has stayed
late into the evening — or early
into the morning on some days —
to check the papers coming off the
press. If we found a mistake, we’d
stop the press, replate and ship a
new error-free file. But the new
press we built a few years ago runs
so fast that even when we caught
a typo, we’d only get it fixed for a
small fraction of our papers. This
year, we abandoned that practice.
Sure, we felt a little queasy about
giving up this last set of eyes on
our product, but the move allowed
us to put more effort into more
important tasks earlier in the day.

What can you
experiment with?
Can you test different sales
tactics, pricing strategies or news
features or columns? If so, measure
results and resolve to fail faster —
if something doesn’t work, quit
doing it. If it works, fantastic! Keep
doing it, look for ways to expand it,
boost it. At the Times Free Press,
we have changed our morning
meeting time and story budgeting
process to support increased emphasis on our digital initiatives.
Do we know enough about our
customers, our readers, our advertisers and our employees? How
can we learn more? Again, this is
a great chance to let your TPA director or TPA staff know about the
need for this kind of research. That
kind of data can help us all meet
the needs of our constituencies.
And they all matter.
And while we must stay focused
on strengthening our individual papers, let’s not forget that the strength

2020 TPA Winter
Convention

Chris Vass is president of the
Tennessee Press Association for
2019-2020. Contact her at cvass@
timesfreepress.com.
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Happy New Year as we open the door to 2020!
We are looking forward to
seeing everyone at the 2020 TPA
Winter Convention in February.
Please make plans to attend the
legislative reception this year.
The last couple of years have
been very well attended, and I
hear from our lawmakers how
much they enjoy spending time
with their local publishers, editors, etc.
In December, the Tennessee
Supreme court ruled that Fair
Report Privilege does not apply
to non-public interviews. As you
know our counsel, Rick Hollow,
was involved in this case.
The Court ruling determined
that the fair report privilege does
not apply to a non-public, oneon-one conversation between a
reporter and a detective of any
sheriff’s departments.
Jeffrey Todd Burke sued Sparta
Newspapers, Inc. for defamation
after the newspaper published
a story by one of their reporters
based on a non-public (not a press
conference, official statement or
sanctioned interview) conversation with a detective from the
White County Sheriff’s Department. Burke’s lawsuit claimed
the article published defamatory

PAULSON

from Page 1

rageously and at considerable risk
published newspapers to make the
case for change.
• Throughout our nation’s
history, newspapers have made
it their business to hold the
powerful accountable. Newspapers haven’t always made a lot of
money, but they’ve always made
a difference.
It’s important to acknowledge
newspapers’ past, but also to express concern about their future.

Digital technology has
been a game changer
Digital technology has upended
countless industries, including
popular music (remember CDs?),
travel agencies, and greeting
cards.
There’s a new generation with
no appetite for newsprint and
who have a general sense that
news should be free. Although
newspapers have moved to build
a business around online news – a

FROM THE
EXECUTIVE
DIRECTOR
CAROL DANIELS
statements that came from that
interview.

Rick Hollow’s overview
and summary of the
ruling:
The fair report privilege was
designed to encompass only public
proceedings or official actions of
the government that have been
made public. The keys here are
public proceedings and having
been made public. A statement
to which the privilege applies is
worthy of public notice, not only
because of the contents of the
statement, but also because of the
context in which it was made. The
fair report privilege applies only
to public proceedings or official
actions of government that have
been made public. This enables
newspapers and other outlets to be
the eyes and ears of members of

little slowly for a societal shift that
began in 1993 – they were never
able to charge ad rates comparable
to what they earned in print. That,
in turn, has led to a reduction in
profits and a corresponding reduction in reporting resources. It’s not
a pretty picture.
That said, too many view this as
a business story about an industry struggling with change and
technology. That’s shortsighted.
If newspapers aren’t around – in
print or online – tax dollars will
be wasted, government corruption
will be widespread and our collective quality of life will suffer.
A world without newspapers
would mean no one sitting in that
press chair at city council meetings,
monitoring how taxpayers’ dollars
are spent.
It would mean voters without
any information upon which to
base a vote, relying only on the
social media and advertising onslaught of partisans and politicians.
A world without newspapers
means we would know virtually
nothing about the communities in

the public who would have been
able to witness the proceeding or
obtain the information had they
been present to see or hear, but at
the same time this limitation ensures that the fair report privilege
remains closely connected to the
rationale from which it originated,
specifically the public’s interest in
being informed of official actions
that are themselves public.
The fair report privilege can be
defeated by showing that a report
about an official action or proceeding was unfair or inaccurate.
Records are generated of public
proceedings or official actions. Any
report on a public proceeding or
official action can, therefore, be
compared to the record from which
it is taken. Therefore, the reader
can easily determine whether the
report is fair and accurate and entitled to protection or not. Judges,
lawyers or litigants would have no
objective means of determining the
fairness and accuracy of a report
if it is derived from a non-public
one-on-one conversation. Only the
parties to the conversation would
know what was said. In such circumstances, every assertion of the
fair report privilege would require
testimony from the parties to the

conversation and an assessment
of their credibility if there was
litigation to determine whether
the report was in fact fair and
accurate.
In sum, we conclude that
expanding the fair report privilege
to nonpublic, one-on-one conversations would constitute a departure
both from the rationale on which
the privilege is based and from
existing Tennessee law defining its
scope and that such an expansion
would unnecessarily complicate
the task of determining whether a
report should be protected by the
privilege. For all these reasons, we
hold that the fair report privilege
applies only to public proceedings
or official actions of government
that have been made public.

which we live. With all due respect
to news broadcasters, they would
be the first to tell you that newspaper content is critical to deciding
what to cover.

our support today more than ever.
The first generation of Americans demanded a free press
because they wanted a check on
government and protection for the
Bill of Rights. That’s a big job, but
newspapers have been doing it for
the past 228 years.
I believe that most of America’s
local dailies and weeklies will continue to serve their communities
for years to come, but we can’t take
that for granted.
All of us need to think about the
high stakes facing a society without
members of a free press maintaining a check on the powerful.
Read. Subscribe. Buy ads. And
if you’re not inclined to do any of
those things, go ahead and write a
check to your local paper anyway.
Think of it as an insurance policy on the kind of country we want
– and need – America to be.

Honest coverage could
be a victim
The biggest loss, though, would
be the disappearance of an honest
broker, writing about the issues
that matter most and giving
citizens a real understanding of
how their community is faring. I
emphasize “honest.”
I’ve written for newspapers as
small as the Elmhurst (Ill.) Press
and as large as USA Today, but the
culture was always the same. Our
job was to serve the public, take no
prisoners and never play politics.
Critics of the press will never
believe this, but I’ve spent 25 years
in America’s newsrooms and never
heard anyone dare suggest that a
story take a certain slant to score
political gains. That would lead to
dismissal.
The truth is that newspapers need

Both Rick and I agree that this
creates more questions than it answers. Rick will be at the Winter
Convention on a panel to discuss
public notices, I hope you all plan
to attend.
Carol
Carol Daniels is executive
director of the Tennessee Press
Association.

Ken Paulson is the director of
the Free Speech Center at Middle
Tennessee State University and the
founder of the 1 for All campaign
for the First Amendment.

FOR YOUR CALENDAR
JANUARY 2020
19-25: 2020 Tennessee Press Association Public Notice Week

FEBRUARY 2020
12-13: 2020 Tennessee Press Association Winter Convention,
DoubleTree Nashville Downtown Hotel, Nashville
17-19: 2020 Key Executives
Mega-Conference, Southern
Newspaper Publishers Association, Omni Fort Worth Hotel,
Fort Worth, Tex.
21: Entry deadline for 2020 TPA
Press Contests
28: Entry deadline for 2020 TPA
Ideas/Circ Ideas Contest

MARCH 2020
5-8: 2020 Investigative Reporters
and Editors (IRE) ComputerAssisted Reporting (CAR)
Conference, New Orleans, La.
11-14: College Media Association
Spring National College Media
Convention 2020, New York
Marriott Marquis, New York City

APRIL 2020
17-18: Journalism Education Association National Convention,
Gaylord Opryland, Nashville
23-28: 2020 International News
Media Association (INMA) World
Congress of News Media, Paris,
France

JUNE 2020
18-19: TPA Summer Convention,
Pigeon Forge
19: TPA Ad/Circ Conference,
Pigeon Forge
19: TPA State Press Contests
Awards Banquet, Pigeon
Forge
18-21: 2020 Investigative Reporters and Editors (IRE) Annual
Conference, Gaylord National,
National Harbor, Md.

OCTOBER 2020
21-25: College Media Association Fall National College
Media Convention 2020, in
conjunction with Associated
Collegiate Press, Atlanta Hyatt
Regency, Atlanta, Ga.

JULY 2021
24-26: 2021 Tennessee • Arkansas • Mississippi Press Associations Tri-State Convention,
Memphis
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Meet them where they are, and that means preparation
Tim manages an ad sales team.
“When I started my career in the
newspaper business, I quickly
learned that advertisers can be
worlds apart in their knowledge of
marketing,” he said. “That’s why
one of my favorite sales principles is the old slogan, ‘Meet them
where they are.’
“This means we have to recognize that our prospects have
different levels of experience. Most
of them don’t have our knowledge
of the intricacies of newspapers.
If we don’t talk to them on their
level, they will tune us out. And
most of them are too polite to
tell us we’re doing a poor job of
explaining things.”
Tim’s comments remind me of
the time my wife and I helped her

AD-LIBS®
JOHN FOUST
father select a car. He loved his
14-year-old car, but it was time for
a replacement, because expensive things were beginning to go
wrong with it.
At the dealership, we found a
nice used car with only 12,000
miles – a much-newer version of
his old model. Our salesperson was
sincere and down-to-earth, but
unfortunately, he was hung up on
technology. He spent most of the

OBITUARIES
Larry K. Smith, former publisher
of The LaFollette Press, died Dec.

26, 2019. His complete obituary will
appear in the February edition.

NEWS

TPA’s 9th annual Public Notice Week is January 19-25. TPA
is working to have material and
information out to you in early
January.
Please plan to participate in this
observance to remind your readers
of the importance of public notice.
Contact Robyn Gentile for more information at rgentile@tnpress.com.

Webinars available
at no charge and includes
those archived
TPA member newspapers
can take advantage of all of the
webinars offered by the OnlineMe-

diaCampus.com for free in 2020.
This access includes all archived
webinars as well.
Based on the great participation
in 2019, the TPA Board of Directors budgeted for this opportunity
and hopes every member will take
advantage of some training.
TPA members will need a special
code to access the webinars. If you
want to access archived webinars, a
separate code will be needed.
Please contact Robyn Gentile, TPA
member services manager, for more
information and if you want to get a
webinar code at rgentile@tnpress.
com or (865) 584-5761, ext. 105.
January topics:
Jan. 10 – Cybersecurity
Jan. 16 – Classifieds 2020
The archived library includes
more than 240 webinars.

Tennessee Press Service
Advertising Placement
Snapshot
ROP:
$146,308
$1,297,893

Networks:
$9,101
$155,529

* The TPS Fiscal Year runs Dec. 1 through Nov. 30

tutorial. I sat in the car with him,
placed my hand over the dashboard display and said, “The first
thing we’re going to do is forget
about all of this.” He said, “That’s
a good start.” Then we reviewed
and practiced some basics until
he was comfortable. When we
finished, he said he was more
confident and even more excited
about the car.
Age and experience make a big
difference. That car salesperson
should have known that a person
of my father-in-law’s age wouldn’t
care about fancy technology. But
he was so blinded by his own
interest that he couldn’t see things
from another person’s perspective.
“It’s all a matter of common
sense,” Tim said. “If a prospect is a

numbers person, we should talk in
terms of numbers – even if we’re
not numbers people ourselves.
If someone is an idea person, we
should focus on ad concepts. Of
course, this means we have to be
prepared to talk to about advertising from all angles.”
Meet your prospects where they
are. Let that be your guideline,
and you’ll be on the right road.
Copyright 2020 by John Foust.
All rights reserved. John Foust has
conducted training programs for
thousands of newspaper advertising professionals. Many ad departments are using his training videos
to save time and get quick results
from in-house training. E-mail for
information: john@johnfoust.com

Zachary named new president of
GA First Amendment Foundation
SUBMITTED
GA First Amendment Foundation

Annual Public Notice
Week set for the week of
Jan. 19-25

November 2019
Year* as of Nov. 30

test drive talking about the screen
in the middle of the dashboard.
He was a walking encyclopedia
of Bluetooth and wi-fi and digital
programming, but my father-in-law
had no interest in those things.
He just wanted to see how the
car drove and learn the relevant
differences between his old car and
the new one. His patience with the
barrage of comments like “Look at
this other cool feature” was a clear
sign that he liked the car.
In spite of the salesperson’s
single-minded focus, my wife’s
dad decided it was the right car
for him. When the transaction
was over, he mentioned that the
salesperson was nice, but extremely confusing. The next day,
he accepted my offer of a simple

December 11, 2019

Jim Zachary has been named
president of the Georgia First
Amendment Foundation.
Zachary, who is CNHI’s deputy
national editor and editor of The
Valdosta Daily Times, was elevated
by the GFAF board of directors in
Atlanta.
Before moving to Georgia, Zachary was an eight-time winner of
the prestigious Edward J. Meeman
Award from the Tennessee Press
Association and the University of
Tennessee, largely being recognized
for open government advocacy and
editorial writing there as well.
Zachary was also a presenter
for a newsroom session at the
2019 TPA Summer Convention
in Chattanooga, where he spoke
about putting more of a focus on
dynamic writing, print, and digital
presentation, strong commentary,
the value of social media and video, and the importance of solutions
and enterprise journalism.
When he takes the reins Jan.
1, Zachary will be just the fourth
president in the foundation’s
history.
He succeeds retired CNN executive Richard Griffiths, who took
over from Shawn McIntosh, edito-

rial director for the Atlanta Journal
Constitution. GFAF founder and
first president Hyde Post established the foundation in 1994 and
served as president for more than
two decades.
“It’s terrific to have someone like
Jim, who has
a broad understanding of the
needs of Georgia
outside Atlanta,
be part of the
organization and
be in this leadership role,” GrifZachary fiths said. “This
is all about the
battle for transparent government,
and Jim has been a champion for
that for years.”
Zachary’s long journalism career
has been centered around defense
of the First Amendment and open
government advocacy.
He is the holder of the David E.
Hudson Open Government Award.
Zachary won the Associated
Press Media Editors Award in 2015,
2016, 2017 and 2018.
He accepted the Georgia Press
Association’s Freedom of Information Award in 2013, 2014, 2015,
2016, 2017 and 2018, for his work
with three different Georgia newspapers.

Zachary has received multiple
community service and public
service awards from APME and
GPA as the result of his work focused on government transparency.
Previously in 2019, he was feted as
CNHI’s Editorial Writer of the Year,
and he has won multiple state and
national recognitions for editorial
writing, mostly focused on open
government advocacy.
“Serving the Georgia First
Amendment Foundation, and even
more importantly, the people of
Georgia who want access to public
records and local government
meetings, is important work that
matters, really matters,” Zachary said. “Defending the First
Amendment and advocating for
government transparency are
noble pursuits and crucial for our
liberty.”
The Georgia First Amendment
Foundation was established in
1994 and is a nonprofit organization that works to educate the public, public officials, journalists and
lawyers on Georgia’s open records,
open meetings and free speech
laws. GFAF is the only organization
in Georgia with the specific mission to advocate for government
transparency, free speech rights
and access to public information,
meetings and proceedings.
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Daily Herald carrier gets Good Samaritan Award

TRACKS
Simpson hired as editor at
Mountain Press
The Mountain Press, Sevierville,
recently hired Cindy Simpson as its
new editor. Simpson comes to the
publication from the Roane County
News in Kingston, where she was
assistant editor.
“We are really excited to have
her. We think her years of experience in news will be an immediate
asset for us,” said publisher Jana
Thomasson.
Jason Davis, who had been
editor at The Mountain Press since
2007, was to remain on as associate editor during the transition. He
will be leaving the publication to
pursue a degree in education.
Simpson spent 15 years at the
Roane County News. She began as
a reporter covering the city of Harriman and town of Oliver Springs.
She also was responsible for the
weekly publication of the Harriman Record, a small weekly that
the Roane County News produced
for a number of years.

In addition
to reporting,
she also served
briefly as an
interim editor
at the Morgan
County News,
Wartburg, before
her promotion to
Simpson
assistant editor at
the Roane County News, Kingston, in 2018.
She expressed her excitement for
the opportunity to join the staff of
The Mountain Press and continue
providing excellent news coverage
to beautiful Sevier County.
“I’m grateful for the opportunity
to join the staff of The Mountain
Press,” Simpson said. “I look forward to getting out in the community to meet the wonderful people
of Sevier County. I’m impressed
with the excellent staff at The
Mountain Press and excited to get
to work providing the best news
coverage to the community.”
The Mountain Press, Sevierville
Dec. 10, 2019

MIKE CHRISTEN
The Daily Herald, Columbia
December 4, 2019

Thirteen Columbia firefighters
and a carrier of the The Daily Herald, Columbia, were recognized
recently by city officials during a
special pinning ceremony.
Inside the city council chambers, The Daily Herald’s Richard
Musgrove was presented with
the city’s Good Samaritan Award
for his actions saving an elderly
woman from a burning vehicle in
November.
“This is an honor,” Musgrove
said after the ceremony, holding
the framed certificate presented to
him by Columbia Fire and Rescue
Chief Ty Cobb.
On Nov. 25, Musgrove was driving down Trotwood Avenue on his
route just before 3 a.m., when he
noticed a red Jeep Renegade that
had caught fire near the rear of the
vehicle.
He saw the car was parked next
to a gas pump in front of a Kwik
Sak convenience store and discovered that the car’s driver was still

inside, unaware of
the fire.
“He set an example that everyone
can follow,” Cobb
said. “His actions
saved a life. . . .
That is what makes
Columbia great
and Maury County
great — having great
people.”
The car’s driver
was reported to be in
Photo by Mike Christen, The Daily Herald, Columbia
a state of confusion.
Newspaper carrier Richard Musgrove, left, shakes
Musgrove and
hand with The Daily Herald publisher Keith Ponanother carrier cut
der, right, joined by Circulation Director Anthony
the woman’s seat
Dezarn, center, after Musgrove was presented
belt and pull her
from the car without with a Good Samaritan Award.
harm as fire crews
like Richard, do big things and
arrived to extinguish
small things to serve our customthe flames.
ers and our community.”
No injuries were reported.
Musgrove says he has been
“We’re all very proud of Richdelivering The Daily Herald on
ard and his efforts to render aid
to someone in need,” said Keith
and off for about 40 years. He first
Ponder, publisher of The Daily
took a position with the local paper
Herald. “All of our contractors are
delivering on bicycle to homes and
a vital part of our business, and
businesses on West 7th Street.

Lessons from a failed newsletter on how to engage with your audience
QUINN RITZDORF
Reynolds Journalism Institute
May 8, 2019

Short Takes is an occasional series that captures interesting work
by Missouri School of Journalism
students.
As part of my RJI Student
Innovation Fellowship with
the Greeley Tribune in Greeley,
Colorado, a co-worker and I were
given the task to start and grow a
paid subscription newsletter, The
Playbook, that covered rural prep
sports in Northern Colorado.
After five short months, the
Tribune’s management ended the
newsletter because we failed to get
enough subscribers, causing the
company to lose money.
I may have learned far more
about audience engagement
through the struggles than I
would have if the newsletter
succeeded.
I was forced to get creative, to
do whatever I had to lure and keep
the audience engaged and coming
back for more. In some ways, we
did just that, even though we ran
out of time.

One of the things I learned is
that audiences love lists, so here
are three ways to engage with
your audience.

1. Give the audience what
they want
The most important aspect of
any journalism is understanding
who your audience is and what
your audience wants.
This seems self-explanatory but
this idea gets lost on journalists, as
many create content they would
want rather than thinking about
their audience. We fell into this trap.
The Playbook covered 11 small
schools across Northern Colorado, and when it first started, we
covered about two schools per
issue with long, in-depth featured
stories.
This meant that we were
leaving out nine other schools
and their communities, which
added up to be about 500 potential
subscribers. So we realized we
needed to create shorter sections
with a wider variety of schools in
each issue. We tried to never leave
a school out.

These new sections included
highlighting players of the day
and giving fun facts about each
school in the league all while still
maintaining the main feature
story in the newsletter.

2. Interact with your
audience
Once we changed the format
of The Playbook, we turned our
attention to the big question —
how do we keep and bring in new
subscribers?
We came up with strategies for
interaction. Readers will come
back if they are personally invested in the content and have a say
in some of the sections. We added
special sections, such as trivia
questions about the high school
league, and contests, where we
asked the subscribers their predictions of a certain games and kept a
running leaderboard.
We also asked subscribers for
submissions of videos or photos of
sporting events to include in the
newsletter, hoping that it would
create more interaction between
us and our readers.

The problem was this newsletter covered such a specific
niche that we didn’t have many
subscribers in the first place,
which affected how many people
actually interacted with us. The
strategy was sound, but it would
have been more effective with a
bigger base.

3. Take advantage of social
media
We had more than double the
number of followers on our social
media accounts than subscribers
to the newsletter, which helped
spread the word of the newsletter
more than we could have done
by word of mouth. The Playbook
quickly gained recognition and
was beginning to grow.
This was in large part due to
another new section we added to
the newsletter. Every Monday, we
compiled the top four male and
female athletes and created a Twitter poll for the community to vote
on the athlete of the week.
It was interesting to see how
much support these athletes
received from their communities.

It became a competition between
schools to vote their athletes to the
top of the poll.
Many of these Twitter polls
would receive 300-500 votes
and have numerous interactions
between athletes and school communities.

Note: Use social media
for growth
Near the end of the newsletter,
schools were tweeting to our
account about score updates or
sports news, which goes to show
how much social media can be
used to grow a publication or even
a brand in a short amount of time.
Quinn Ritzdorf is a convergence
journalism student at the University of Missouri. During Spring 2019,
he worked at the Greeley Tribune
on a prep sports newsletter that
covered 11 schools in Northern
Colorado.
Previously he has created multimedia stories for KBIA, KOMU,
Missouri Business Alert and the
Columbia Missourian. Follow him
on Twitter @QRitz7.
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The heartbreaking reason why school officials
spent one night on roof of elementary school
be brewing in here,
hopefully. We’ll just
get up and get ready
for another day.”

LASHERICA THORNTON
Jackson Sun
May 7, 2019

The South Gibson County
Elementary School principal Billy
Carey and the district’s superintendent Eddie Pruett spent
Monday night, May 6, on the roof
of the elementary school after its
students surpassed two funding
goals of $7,000 and $15,000.
In less than a month, the
preschool-through-third grade
students raised $28,830.74 for St.
Jude Children’s Research Hospital
and its patients.
Even though the fundraiser
ended in February, the arms of St.
Jude reached South Gibson last
week when a teacher’s two-year
old daughter was diagnosed with
B cell lymphoblastic leukemia and
has been at the hospital since.
Rachel Sanford, a first-grade
teacher at the school, found out
Thursday about her daughter
Josey’s diagnosis.
They went to the doctor Thursday night because of bruising on
her legs. Sanford said she thought
it was normal for a toddler, but
was shocked when they had to go
to St. Jude immediately.
“St. Jude has been wonderful at
helping and answering all of our
many questions,” she said. “Our
community of Medina has shown
so much love and prayers the past
five days.”
Carey said the raised funds are
now being used by people the
school and community work with,
care about and love.
“It’s amazing for this age group
to see how donations toward organizations help people,” he said.
Sanford’s friend Callie Craig,
the St. Jude coordinator and a
first-grade teacher, said they were
blessed to be in a community,
where parents and students care.
Even though students learned
about the children their donations
would impact, Craig said the kids
were distant, in a sense, because
the children were unknown. With
Josey’s diagnosis, the kids knew a
child that would receive toys, food
and shelter at St. Jude.

Awareness,
connection and
a difference

Photos by Kenneth Cummings, The Jackson Sun

Top photo: South Gibson County Elementary School principal and Gibson County Special School District superintendent Billy Carey and Eddie
Pruett wave to students from the roof of the school, Monday, May 6. Carey and Pruett told students if they reached their fund raising goal for St.
Jude, they would sleep on the roof for one night. Below: South Gibson
County Elementary School students look up at their principal and superintendent Billy Carey and Eddie Pruett on the roof of their school.

Fundraiser goals
The school does the fundraiser
each year between late winter
and early spring. Last year (2018),
the elementary students raised
between $12,000 and $13,000.
More than doubling that
amount made Craig proud. She
said students recognized the cause
they were donating to.

The school, itself, had a math-athon, where they did math to save
a life. For students who raised
funds, some made the fundraising
unique, like a student who baked
hot cinnamon rolls for donors
and a past student who painted
a strawberry on a rock for every
donation.
When Carey set a goal of $7,000,

Before the teacher’s daughter was
diagnosed, Craig
said the fundraiser
was amazing even
after the last day
because students
would still donate.
South Gibson County Elementary School princiShe said it showed
pal Billy Carey stands next to a tent on the roof of how thoughtful the
the school, Monday, May 6.
children were, like a
student who donated
Pruett, the superintendent, said
her
birthday
gifts
to the kids of St.
it was low considering previous
Jude.
year donations. So, he challenged
“It was because of this fundstudents to raise $15,000, which
raiser;
this fundraiser brought
the students exceeded as well.
awareness,”
she said.
As the superintendent, Pruett
But,
with
news
about the diagsaid many families and students
nosis,
students
were
able to make
are blessed, yet just as many are
a
connection.
struggling. He said no matter
When Sanford told her kinwhat families are going through,
dergarten daughter Stella about
it’s rewarding to see a community
her sister Josey’s leukemia, Stella
give back.
replied that she was like the kids
they raised money for at school,
To outdo a camel
Craig said.
“She made a connection because
When a goal is reached, the prinshe had participated at school,”
cipal is challenged. For example,
she said. “It touches lives. It really
Carey rode a camel two years ago
makes a difference in their lives
and did a golf cart race last year.
because their world was turned
Craig said she thought, “What
upside down in a matter of hours.
could outdo a camel?”
“And, you don’t know what
Wanting to make it bigger and
you’re going to do. Through
better, she got the idea to have the
principal, and later the superinten- fundraisers and people helping St.
Jude, you don’t have to wonder
dent, camp out on the roof.
what you’re going to do.”
Equipped with tents, food, and
Sanford said her six-year old
shade, he and Pruett braced themdaughter Stella knows and underselves in the hot sun. On Monday
stands more than normal because
before he took to the roof to set up
of the St. Jude fundraiser at the
shade, Carey said he’d wake up
school.
in his pajamas and start Tuesday
Yet, the hardest part of it all has
as any other day. Because Tuesbeen the fact that Josey is just two
day would be pajama day for the
students and teachers — another
years old and doesn’t understand
reward of the fundraiser — he’d be what is going on, Sanford said.
able to blend right in.
“We are taking this day by day
“Thank goodness we have
and hour by hour,” Sanford said.
pajama day tomorrow (Tuesday),”
“This will be a long road and we
Carey said. “I’ll probably be in
are thankful for those who are on
my pajamas and the coffee will
Josey’s Journey with us.”
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Toddler saved by first responders becomes Hendersonville firefighter 18 years later
TENA LEE
Hendersonville Standard
May 10, 2019

For Hendersonville resident
Tim Jones, watching his son Zack
graduate from the Tennessee Fire
Service and Codes Enforcement
Academy recently was a full-circle
moment he won’t soon forget.
Zack Jones, 20, was one of nine
Hendersonville firefighters to officially graduate from the academy
on May 3. His father couldn’t help
but think about the near-tragic
event 18 years ago that Zack credits
for inspiring him to become an
emergency responder.
Submitted photos

‘Touch-and-go’
Tim Jones had been working out
of town in Kentucky in March of
2001 when someone told him he
needed to call home immediately.
After learning that his youngest
son, two-year-old Zack, had choked
on a gum ball and aspirated, Jones
headed down I-65 to Huntsville,
Ala., where the toddler was being
taken via Lifeflight helicopter.
“My mother told me what
happened, and I drove down the
interstate at like 90 miles per hour,”
recalled Jones. “All of the beds were
full at Vanderbilt and the closest
pediatric ICU was in Huntsville. He
was in surgery when I got there.”
Jones would learn later that Zack
had gotten ahold of a gum ball
meant for one of his older siblings.
No one was sure how long the toddler’s airway was blocked because
his brother Corey had to first get the
attention of their mother, Michelle

Zack Jones (left), pictured here with his father Tim, has wanted to become a Hendersonville firefighter since he was helped by first responders as a toddler.
Detwiler, who was deaf. Someone
alerted a neighbor who dislodged
the gum ball and called 911.
According to a news report at the
time of the incident, paramedics
and firefighters stationed at Fire
Station 1 on Luna Lane responded
to the Lakeshore Apartments within minutes of receiving the call.
Zack was taken to Hendersonville
Hospital before being flown to the
Huntsville hospital.
“No one knew how long he had
been without oxygen,” said Jones.
“That’s what made it so touch-andgo. The doctors could never tell
us he was going to be OK until he
woke up.”
The toddler was kept in a medically induced coma for eight days
before waking up. He was released
from the hospital four days later.

Tim Jones says he stayed by his
son’s side the entire time watching movies like “Toy Story” and
“A Bug’s Life” more than a dozen
times. The dad says he knew for
sure his son would fully recover
when he started singing a local
radio station’s jingle unprompted
on the way home from Huntsville.
“When he chimed in to sing, that
was the first thing he responded to
on his own,” Tim Jones recalled.
“It was something so small, but we
knew then he was going to be OK.”

‘A noble career’
Zack says he has little memory of the accident, but always
remembers wanting to become a
firefighter.
“I vaguely remember my dad vis-

Innovative journalism projects sought by RJI
SUBMITTED
Reynolds Journalism Institute
December 11, 2019

Is there a journalism challenge
you or your newsroom has wanted
to tackle, but haven’t had the time
or resources to focus on the idea?
Could the project benefit the
industry as a whole in some
way and strengthen democracy
through better journalism?
If you answered ‘yes’ to both
of those questions, then consider
applying for a 2020–21 fellowship
at the Donald W. Reynolds Jour-

nalism Institute at the Missouri
School of Journalism. Application
deadline is Jan. 17.
RJI Fellowship projects typically
devise new strategies or models
for solving a problem, build new
tools, or create a prototype or
advance a prototype so it is ready
for investment or launch during
an eight-month fellowship. This
year’s fellows are working on a
variety of projects, which include
developing a best practices guide
for better gun violence reporting,
helping news outlets take advantage of push notifications, and

developing a platform to produce
audio stories on smart speakers
that can contrast or expand based
on the reader’s interest level in a
topic.
“We are looking for projects
that are innovative, practical
and useful to journalists and
newsrooms worldwide,” says Kat
Duncan, RJI’s interim director
of innovation. “We want to fund
ideas that will not only accomplish
something that the individual or
organization believes in, but that
See PROJECT Page 11

Nine Hendersonville firefighters graduated from the state fire academy
on May 3. Zack Jones is third from the left.
iting me,” he said. “But I’ve heard
about it over the years. Hearing the
stories of what happened, it just
sparked an interest in that career.”
Zack remembers visiting the
Luna Lane fire station for years after the incident at Christmas time.
“We used to always take them
food to sort of say, ‘thank you,’” he
recalls.
In 2016, Zack and Corey met
with HFD Capt. Dennis Allen, who
has since retired. The two told
Allen they were thinking about
joining the fire department and
Allen told them what they needed
to do to make their goals a reality.
The two brothers went to take
the eligibility test in September
of 2016, but Zack was just shy of
turning 18.
“I had to wait another year to
take the test,” he said.
Corey Jones, 23, joined the fire
department in 2017 while Zack was

hired in December of 2018.
“I love that I get to work with
my community – that I get to see
familiar faces everywhere I go,” said
Zack, who is assigned to Station 3
on Bonita Parkway. “I want to give
other people the second chance that
I got when I was two years old.”
Tim Jones says he’s proud of
both of his sons.
“I couldn’t ask for a more noble
career for the both of them,” he said.
“They made me proud growing up
and it kind of continues now.”
And then there’s that full-circle
moment he had recently with his
youngest son.
“How many people have the
opportunity of having what could
have been such a tragic event like
this come full circle in such a
positive way?” he asked. “Hopefully
the story will continue with other
people who will have their lives
saved through him.”

Board to consider Dickson Post’s application Feb. 12
The Dickson Post’s membership application is recommended for approval by the
TPA Membership Committee. The Board
of Directors will consider this application
on Feb. 12, 2020.
On Dec. 17, in accordance with procedures, the Board of Directors notified the
membership. If there are no objections
from a TPA member newspaper within 30
days (by 5:00 p.m. EST on Thursday, January 16, 2020) then the agenda will include
the application.
In the event a member objects to
membership by a publication based upon
criteria outlined in the bylaws as qualifications of newspaper members an appeal to
re-consider the application may be made,
if notice of appeal is received within 30
days of the committee’s recommendation
for membership.

In such events the TPA member
objecting must provide the reason for
the objection and provide documentation supporting their position that the
applicant is not eligible for membership
based on the bylaws. Objections should
be addressed to TPA President Chris Vass
(cvass@timesfreepress.com) and Membership Committee Chairman Keith Ponder
(kponder@c-dh.net).
The objecting newspaper shall provide
supporting evidence to the Membership
Committee chair within 10 business days
of the objection.
Expenses incurred by the subcommittee
in the course of their investigation will be
borne by the TPA member objecting to
the membership application. The board’s
ruling is binding.
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Family research in old community newspapers in Indiana
shows value of printed page and granular local reporting
When Jim Phillips of Lexington, Ky., started poring through
microfilm copies of old newspapers
to research his family history, he
thought it would be “a legacy to
be left for my family and others,
documenting the world of my parents’ youth and their home Pulaski
County, Indiana,” as he writes in
a research paper for an independent-study course I supervised at
the University of Kentucky.
But Phillips experienced
something that may make printed
newspapers last longer than many
think: the serendipity that often
manifests itself in scanning the
pages of a newspaper, discovering
and digesting information that you
aren’t specifically seeking.
He also discovered a fundamental element of community
newspapers that may also make
them survive, in whatever form:
the granular coverage of individual
lives that weave together to form
a community. That led him to
expand his work to the independent-study course in journalism.
“When this project started,
I was merely looking for items
mentioning my family, but it
soon expanded to other items that
interested me,” Phillips writes.
“This occurred – as my journalism
professor, Al Cross, aptly pointed
out – because of the wide variety
of information displayed on each
newspaper page.”
Newspaper serendipity was
well-described in The New York
Times by Bill McKeen, chairman
of the Department of Journalism
at Boston University, when he held

ABOUT
COMMUNITY
WEEKLIES
AL CROSS
the same job at the University of
Florida (after teaching at my alma
mater, Western Kentucky University). Bill required his students to
read the Times in print, not online,
when you “find only what you’re
looking for.” He defined serendipity as “the ability to make fortunate discoveries accidentally” and
called it “a historian’s best friend,
and the biggest part of the rush
that is the daily magic of discovery. It’s one of those small things
that make life worth living, despite
all the torment, pain, tragedy and
stifling Interstate traffic.”
As Phillips scanned the pages
of the Pulaski County Democrat
and the Winamac Republican,
he found not only things that he
didn’t know about his family, but
many other happenings -- some of
which constituted narratives about
individuals and families, and economic, technological and cultural
trends from 1924-25, the years his
parents were born, to 1947, the
year he was born. It’s all there:
the Ku Klux Klan, Prohibition, the
Great Depression, World War II
and so on.
The project showed the value of
newspaper archives in researching
trends, some of which Phillips

notes with striking examples,
such as Chet Reynolds, who wrote
a letter to Santa Claus in 1925,
when he was 7, asking for “an
electric moving picture machine.”
In October 1947, as manager of the
Home Appliances and Radio Store,
he ran an ad announcing that it
had a “telivision,” and in May
1948 one of the papers pictured
him installing the antenna for “the
first home television set in Pulaski
County.”
Phillips writes in the first
paragraph of his research paper,

“I came to know my hometown
just before my birth, because the
reporting of these weeklies was
relentlessly local.”
And granular. In those days,
there was no enterprise reporting,
but plenty of personal reporting.
“Births, marriages, deaths, and
courthouse reports were frontpage staples,” he writes. “In each
issue, Sunday dinners, family
visits, short trips and parties were
routinely reported by correspon-

dents for each of the county’s five
to eight communities and their adjacent farms. Hospitalizations and
long trips were also announced,
without concern for confidentiality
and burglaries.”
This amounted to a lot of
information. “The number of
people mentioned in an issue was
about 2,500,” Phillips estimated,
including as one of his many illustrations a house ad that bragged
about 2,630 names in one edition.
“Although it included visitors from
outside the county, that number
is significant in a county with a
population of about 11,000.”
Community correspondents are
much less common today, but are
still seen in some rural newspapers. I wish there were more of
them. Times have changed, and
most of the information a weekly
correspondent might report would
already be known, but the best
correspondents also include insightful personal observations and
valuable background knowledge of
their communities.
I like to say that every American
has the First Amendment right
to commit journalism. At a time
when every American has the
ability to publish, without understanding the responsibilities of
journalism, it would serve us well
to have a cadre of correspondents
in every county, citizen journalists, serving as connectors to the
local newspaper and helping their
neighbors identify with it.
This column was originally posted Aug. 24, 2019. Al Cross edited

and managed weekly newspapers
before working 26 years for the Louisville Courier Journal and serving
as president of the Society of Professional Journalists. For 15 years, he
has directed the Institute for Rural
Journalism and Community Issues
at the University of Kentucky, where
he is professor of journalism.

News media are the first and most effective means for exercising our five First Amendment freedoms
DAVID CHAVERN
News Media Alliance
December 11, 2019

For centuries, citizens have
turned to their local news publication for local breaking and
investigative news, as well as to
learn about hot-button issues in
their communities. In the last
15 years, with the rise of digital
communications, many readers
have changed their preferences to
digital formats and social media
over print for their news. But long

before social
media came
onto the scene,
news media have
enabled us to
exercise all five
freedoms.
As we recently
celebrated NaChavern
tional Newspaper Week, we
were raising awareness about our
five First Amendment freedoms, as
outlined in the U.S. Constitution
— freedom of the press, speech,

religion, petition and assembly —
and the ways the news media help
promote and protect those freedoms. Those five freedoms seem
so basic, and we sometimes may
take them for granted, but there
are surprisingly few channels that
allow us to exercise all five freely.
Through news media, citizens
can express themselves and
advocate for their causes, whether
they be political, religious or just
personally meaningful to us; share
our thoughts and ideas; petition
the government; and plan assem-

blies. News media can be our own
personal amplifier for sharing our
unique perspectives, as well as a
wider lens through which to view
and engage with our communities.
Much in the way we use social
media (but more civil, in my opinion), news media offer a forum, for
the people who matter most – the
members of our own community.
But beyond offering a means
for citizens to exercise their First
Amendment freedoms, news media also help protect those rights:
through their role as government

watchdogs. News media are often
the first to report when government officials try to overstep their
bounds and hinder Americans’
right to information, made available through freedom of the press.
Journalists work to keep the legislative process transparent and hold
government officials accountable.
Perhaps because of our prominent
mention in the Constitution, news
media are uniquely committed to
See CHAVERN Page 12
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Williamson County mother files public records suit against Tennessee School Boards Association
A Williamson County mother,
represented by the Beacon Center
of Tennessee, has filed a public
records lawsuit against the Tennessee School Boards Association after
being denied access to the association’s records.
The lawsuit, Marren v. Tennessee School Boards Association,
claims that the association is the
“functional equivalent” of a government entity under the functional equivalent doctrine established
by the Tennessee Supreme Court,
and thus its records are subject to
the Public Records Act.
The school board association,
in denying public records requests
from Karrie Marren, claimed it was
“a private, nonprofit organization”
and was not subject to the Tennessee Public Records Act.
Marren had requested:
• TSBA’s training materials for
school boards;
• “Any and all communications
with legislators, school board members, superintendents and other
elected or public officials about
your 2018 and 2019 Legislative
Agendas;” and
• “Any and all documents

TCOG
BLOG
DEBORAH FISHER
specifically pertaining to TSBA’s
position statements on governance
(particularly TSBA’s desire to
‘reduce state education law for the
purpose of eliminating unconstitutional, conflicting, redundant, and
unnecessary statutes), and allocation of public funds (particularly
advocacy supporting the idea ‘that
funds raised by general taxation
for educational purposes should
be administered by public officials
and should not be used to support
privately operated schools through
tuition tax credits, vouchers, or
block grants’).”

Functional equivalent doctrine established in 2002
The functional equivalent doctrine in Tennessee was established
in 2002 by the Supreme Court in

Memphis Publishing Company
v. Cherokee Children and Family
Services.
Cherokee, which had been
contracted by the Department of
Human Services to connect parents
with publicly subsidized daycare,
had refused a request by The Commercial Appeal in Memphis for
records of their operations.
In finding that Cherokee was
subject to the Public Records Act,
the Court said that the public
records act “serves a crucial role in
promoting accountability in government through public oversight
of governmental activity” and added that Cherokee provided a service
that traditionally was a government
function.
The determination of whether an
entity falls under the “functional
equivalent” doctrine hinges on
“whether and to what extent the
entity performs a public function”
the Court determined.
Factors the Court said would
be used to analyze who might be
covered included “the totality of
circumstances” but included four
considerations:
1. Whether and to what extent

Suit argues School Boards
Association is subject to
Public Records Act

• Its legal recognition, board
composition and level of state
control; and
• Its designation as a “political
subdivision” and its ability to
participate as an employer in the
state’s retirement plan.
The case was assigned to Davidson County Chancellor Patricia
Head Moskal.
Braden Boucek, attorney with
the Beacon Center, is representing
Marren in the case. (Boucek is on
the board of directors for Tennessee
Coalition for Open Government.)
While the case only deals with
the Tennessee School Boards
Association, its significance could
reach much further. Several government associations exist that do
the same type of work as TSBA for
other types of government entities,
such as for municipalities, county
governments, public utilities and
public hospitals.

In this case, Marren argues that
TSBA is the functional equivalent
of government because of:
• The public service it performs;
• Its significant amount of public
funding;

Deborah Fisher is the executive
director of the Tennessee Coalition
for Open Government. (TCOG). This
blog was originally published on the
TCOG website on Dec. 19, 2019.

it provides a public or government
function;
2. The level of government
funding;
3. The extent of government’s involvement, regulation of or control
over the entity; and
4. Whether it was created by the
legislature or had been found earlier to be open to public access.
Since the Cherokee decision
in 2002, courts have applied the
“functional equivalent doctrine”
to groups such as the TSSAA
(Tennessee Secondary Schools
Athletic Association), CCA (Corrections Corporation of America,
a prison-management firm), and
a private firm that has a contract
to manage Nashville’s Bridgestone
Arena.

Consider cost and employee comfort when replacing computers
WILMA NEWBY
Oklahoma Press Association
September 1, 2019

Editor’s note: The following commentary is reprinted by permission
of the Oklahoma Press Association.
It appeared in the September 2019
edition of their monthly membership publication, The Oklahoma
Publisher.
If it’s time to retool your newspaper’s computer equipment, you
may be weighing the options of an
Apple Mac computer vs. a Windows PC.
You also might be considering
used equipment that can run the
new Adobe Creative Suite and has
a fast WiFi/Ethernet.
Let’s do a comparison. I’m going
to use a 1TB hard drive, 8GB RAM
memory and an i5 coprocessor as
the minimum requirement.
The first thing everyone looks at
is the price. That used Apple computer is going to cost at least $100
more than a comparable Windows
10 system.
With the Apple setup, you can

expect to get a beautiful monitor
with great resolution and a 1000
BT Ethernet. The operating system
may be a little older, but it can be
updated for free.
Apple’s suite of software comes
with Preview, a PDF editor that
will read text in a PDF in the
newer OSX versions. You’ll also get
Apple’s iWork suite, which includes
Pages, a word-processing program
with layout capabilities; Numbers,
a spreadsheet program similar
to Excel; and Keynote, similar to
Windows’ PowerPoint. However, to
really deal with Word documents
on a Mac requires LibreOffice or
OpenOffice. But that suite of software for the Apple is free, which
means all you need to put out the
newspaper is the Creative Suite,
accounting software and a setup to
run circulation programs.
Now let’s look at the Windows
setup. Again, I’m using the i5 coprocessor with 8GB Ram memory.
This PC will come with Windows 10, Microsoft’s latest operating system, but will most likely
require some updates. If you can
afford it, look for Windows 10

Professional.
Now let’s look at the software.
Microsoft Office 365 is $69.99
annually, or you can pay by the
month. Or, just like the Mac, you
can use the free OpenOffice or
LibreOffice.
Refurbished PCs often come with
a USB WiFi device that’s not very
fast. You may want to purchase a
faster one. If so, make sure it’s a
1000 BT Ethernet.
Whether it’s a Mac or PC, both
platforms require antivirus protection. Macs may get fewer viruses,
but they can still be infected.
It all boils down to what your
staff is most comfortable with.
Most new employees are familiar
with both platforms.
Mac computers tend to last longer simply because many PCs get
bogged down with virus attacks.
Walmart and Amazon are
running neck and neck on prices
these days, and there are many
used dealers that have been around
for a long time. The computers described in this column are around
four to five years old but have a few
more years of life in them. Prices

for the PCs starts at around $350;
Macs start at $465.
When you start looking at new
computers, the price goes up. The
least expensive iMac is $1,099;
a comparable Dell PC system is
$979.99.
You might consider a Dell tower
with a cheap monitor for around
$779.99 (knock off $100 if you
already have a monitor). The Mac
Mini is $799 but you’re going to
need you’re own keyboard, mouse
and monitor. Prices run neck and
neck for new or used.
It is attractive to find a $300 computer and run with it as long as it
lasts. Over a 10-year time frame it
will probably even out whether you
buy used or new.

New Apple iPhones
Apple announced some new
iPhones at its lackluster press event
(in 2019), but most customers
will wait for the G5-based phones
expected to be out next year.
The iPhones released this past
year are better versions of 2018’s
with three camera lenses, includ-

ing an ultrawide-angle lens. The
co-processors on the new phones
are faster than any other phone out
there. They also have much longer
lasting batteries – four to five
hours more than the last phones.
Apple also claims the devices are
waterproof to a maximum depth of
2 meters for up to 30 minutes.
The press event also showcased
a beautiful, new 10.2-inch iPad.
The iPad was to come with iPad OS
13, Apple’s Smart Connector, Apple
Pencil support and A10 Fusion processor – all for $329. Apple TV+
is being launched for $4.99 per
month for 6 people. Apple Arcade,
a gaming subscription service, will
be available for $4.99 a month for
5 devices.
Mac OS Catalina 10.15, a new operating system, was to be released
in October and includes a new
feature called Sidecar. Sidecar extends your workspace by allowing
you to use your iPad as a second
Mac display. This is really going to
improve file sharing between the
See COMPUTERS Page 10
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10 things I’d tell publishers about their newspapers
Editor’s note: Ed Henninger
recently retired after 30 years as a
newspaper design consultant. This
column, originally published in the
February 2016 edition of The Tennessee Press, is reprinted here with
Ed’s permission.
Some time back, I was asked to
give a quick after-lunch talk to a
group of publishers at a statewide
newspaper convention. It was
short notice. I only had a half-hour
to put together some thoughts. I
decided I’d seize the opportunity
and give them my “Top Ten” list of
ideas for community newspapers.
Here they are:
1. Print is not dead. More new
community newspapers are starting up. Advertisers believe in the
value of print. Readers still want
print. So, please, let’s stop with the
“newspapers are dying” garbage!
It’s just not true.
2. Local, local, local. We all
know the mantra. Metro and
regional newspapers have tried
time and again to go “local.” They
can’t. They don’t have (or won’t
commit to) the resources it takes—
in people, energy and time—to do
community journalism. But we
can. And we prove that in every
issue. We are focused on local people, places and events. It’s what we
do . . . and we do it very well.
3. Sports is big. We often struggle to find ways to get younger
readers. To my mind, the answer
here is simple - and most of you
are already doing a good job with

COMPUTERS
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two devices.
Also announced was the new Apple watch Series 5 with new materials and types of bands that can be
put together any way you want. The
watch also has a new retina display
that is always on.You can still pick
up a Series 3 watch without all the
new bells and whistles for $199.

Remove backgrounds
This month’s most frequently
asked question is how to knock out
a photo’s white background and
place another photo on top of it.
There’s actually two ways to do
it – one in Photoshop and one in
InDesign. If the project is complicated, I use Photoshop.
There are several ways to do this,

BY
DESIGN
ED HENNINGER
it: Sports. Your sports coverage is
about kids. It’s about them, their
friends, their classmates. Boost
your sports coverage and you’ll
boost your number of younger
readers. Yes, there are other events,
like scouting, classroom achievement, choir, band and the like. But
sports is big. Give it big coverage.
4. It’s OK to be a booster. Nothing disappoints me (and readers,
too, I think) more than to see a
newspaper in a town where a team
has just won a district or state
championship and the story and
photos are . . . splashed all over
the sports front. It’s disappointing
because those stories and those
photos should be on the front
page. Most of your readers will be
happy to see a page 1 poster of the
winning basket or the winning
touchdown. Sports is about striving
and achievement and dedication
and teamwork. What’s wrong with
celebrating those qualities. And,
yes, on your front page when the
achievement is big.
5. Build revenue. The metros
think they have the answer to satisfying their corporate owners and

stockholders: cut costs. They’re
into hubs and outsourcing and
layoffs. At community newspapers, we’re already thin. But we’re
also aggressive when it comes to
generating new revenue. Let’s keep
searching for new approaches, like
selling ad position and selling our
photos online and creating more
options for advertisers. This takes
some rethinking on our part but
that’s what got us here.
6. Invest in your people. If your
editor and/or writers need some
training, look for ways to get that
for them. Your state press association is always a good resource. If
you’ve just invested in some new
software, give those who will use
it some training so they can make
Get younger readers into your paper by highlighting sports . . . it’s
all about them and their friends.
the best use of it. If your ad staff
has won some awards in the annual press association contest, reward
them by sending them to the state

convention so they’ll know how
much you appreciate their work.
7. Invest in your product. You
don’t need to be the first to buy
that new Mac, but don’t be the
last. You don’t need to be the first
to upgrade your system software,
but keep it at least reasonably up
to date. Your newspaper is your
business. It’s just sound business
practice to make sure you have the
tools you need to get the job done.
8. Design matters. What’s
the first thing your readers and
advertisers see when they look at
your newspaper? Right: its design.
If your design is outdated, if your
text makes your paper difficult to
read, if your content placement is
inconsistent . . . your newspaper
is less than it can be. And readers and advertisers will find it
wanting. Some might choose not
to read, some might choose not
to advertise…until you fix those
problems.
9. Be the best at who you are.

but the one I’m going to describe
is a quick way to go about it when
you’re on deadline.
Open and correct the photo for
print in Photoshop. It’s easiest
when your background is white. If
it isn’t white, you’re going to need
to cut out the object with a slightly
feathered selection tool, around 2
to 3 pixels.
Use the Magic Wand tool and
select the white art by clicking in
the white area. (Note: the Options
bar at the top of the screen allows
for tolerances to make a better selection. Just play with the numbers
until a desired selection is found.)
Then go to Select menu > Modify > Feather. Use a 2 or 3 pixel
Feather Radius to take the hard
edge off the art. Next, go to Select
menu > Inverse. This should
select the art and not the back-

ground. Then go to Edit > Copy.
Now go to File > New. When
the new document box comes up
make sure the resolution is the
same as your original document
and that the background content is
transparent.
The new file should have a
checkered pattern, which indicates
a transparent background. Now
go to Edit > Paste. Now this is the
trick. Go to Save As and choose
Photoshop as the file format. It will
hold the layers in InDesign and
the art can be layered on top of
the background art in InDesign or
Quark. The end result gives clean
lines and a good ending product.
This method works great but if
your art is simple, you can accomplish the same thing without ever
leaving InDesign.
Start by placing your art in

InDesign (File > Place). Now go to
Object menu > Clipping path >
Options.
Choose Detect Edges from the
dropdown menu under Type. Now
use the threshold and tolerance
setting to get the desired result.
If things still aren’t perfect,
choose the Pen tool by holding it
down and selecting the Delete Anchor Point tool. Click on the handles
around your art until the extra handles are eliminated and things look
smooth. If you need to add a point,
select the Add Anchor Point tool.
These tools take a little practice
but are well worth learning. The
Convert Direction Point Tool lets
you change how the Anchor points
work as far as creating a curve or
corner. The white pointer tool is
your friend and allows you to move
the lines closer to the art.

Illustration by Ed Henninger

Get younger readers into your paper by highlighting sports . . . it’s all
about them and their friends.

You’re not a metro or a regional
newspaper. Most of you don’t
carry wire, but you do carry those
obits and events listings and city
and county council meetings that
are important to your readers.
Most get only limited national
advertising, but you are the only
source of advertising for that shoe
shop down the street. Don’t try
to be what you’re not - but do
everything you can to be the best
at what you do. Your newspaper is
part of the lifeblood of your community. Keeping that in mind will
drive you to do your best.
10. Remember who the boss is.
Sorry . . . you may be the publisher, but you’re not in charge here.
Your readers and advertisers are
the real boss. It’s your obligation
as a publisher to bring them your
best—in every issue. You’re the
chief support person for your
folks who do the writing, editing,
designing and selling of your
product. You’re all working toward
giving readers and advertisers a
newspaper they’re proud to call
“my paper.” It is theirs, you know
. . . they’re only letting you run
it for them while they go about
the important business of living
their lives and contributing to
the success and welfare of your
community.

Free webinars
for TPA members
Jan. 10
Cybersecurity

Jan. 16
Classifieds 2020

Visit
www.OnlineMediaCampus.com
to register for webinars.
Contact rgentile@tnpress.com
for the coupon code.
240 archived webinars
are available
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3 health-care companies file reverse public records suits to stop release of price information
DEBORAH FISHER
TN Coalition for Open Government
December 16, 2019

Three large health-care companies who contract with the
state of Tennessee to administer
the state’s employee health-care
plan have filed lawsuits to prevent
the Department of Finance and
Administration from releasing
payment information.
They claim the release would
reveal confidential price information that they have negotiated with health-care providers
for certain medical and health
procedures — information that
they say is proprietary though
the state pays the bills through its
self-funded plan.

Releasing price information violates Sherman Act,
companies claim
Laurie Lee is executive director
of Benefits Administration in the
state Department of Finance and
Administration. Her office was
preparing to release information
about the state’s health plan price
information under the Tennessee
Public Records Act and notified
the companies that administer the
plan. Those companies then filed
reverse public records lawsuits to
oppose release of negotiated price
information. The state did not
oppose their requests for temporary restraining orders to prevent
the release.
BlueCross BlueShield of Tennessee and Cigna filed separate
actions in federal court on Friday,
Dec. 13 (BlueCross Blue Shield
of Tennessee, Inc. v. Lee et al,
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can help the industry too.”
Fellows can either work on
projects themselves through
a residential or nonresidential
fellowship or work directly with
an organization on a project
with an institutional fellowship
through RJI’s flexible fellowship
options. Residential fellows are
required to move to Columbia, Mo.
Fellowships are open to those in
the U.S., as well as international
journalists.
Among the various resources
available to fellows includes access
to a communications team that

Cigna Health and Life Insurance
Co. v. Lee et al), claiming that
the release of state payment
information would violate federal
antitrust laws (the Sherman Act)
and the 5th Amendment to the
U.S. Constitution.
Optum, which provides an employee assistance program and behavioral health
organization
services for the
state’s healthcare plan, filed a
lawsuit in state
court, claiming
violation of the
state trade secret
Lee laws, among
other claims.
The suits are
known in public records circles as
“reverse public records” lawsuits
because they are suits by third
parties against a governmental
entity to preemptively prevent the
release of government information
to public records requesters. In
some cases, the third party also
files suit against the requester.
They can be particularly pernicious
because oftentimes there is no one
representing the public’s interest in
protecting access to public records
and open government in these
actions.

State does not oppose
and judges grant temporary restraining orders
The state attorney general’s
office, represented by Deputy Attorney General Janet Kleinfelter,
did not oppose the companies’
requests for temporary restraining

can help promote the project, as
well as assistance from programmers and students who can
produce marketing plans. There
is also support for those wanting
to conduct market research or test
an idea at one of the Journalism
School’s newsrooms.
Where could an RJI Fellowship
take your idea?
Learn more about RJI Fellowships and apply at RJIonline.org/
fellowships.
If you have questions, contact
Kat Duncan, interim director of
innovation at RJI, by emailing her
at duncank@rjionline.org.

orders to prevent
information release. Two TROs
were issued by
judges on Friday,
the same day the
suits were filed.
District Judge
Eli Richardson
Daniel granted a temporary restraining
order in the BCBST case. Chancellor Ellen Hobbs Lyle granted
a temporary restraining order on
Dec. 13 in the case filed by Optum
in state court.

Daniel sought payment
information in state
health plan
State Rep. Martin Daniel,
R-Knoxville, requested de-identified information about state
payments under the health-care
plan.
The public records request that
set off the lawsuits was made by
Daniel, a member of the Joint
Fiscal Review Committee. Daniel
requested payment information
— minus any personally identifiable information — for healthcare services. Such information
would show the prices that
BCBST, Cigna and Optum agreed
to for certain services, sometimes
referred to as the “allowable
amount” under their contracts
with health-care providers.
According to court filings, the
state was preparing to release
the information after implementing exceptions to the Tennessee

Public Records Act and applying
the HIPAA de-identification standards. They notified the companies that they intended to provide
information to Daniel at 1 p.m.
today (Monday, Dec. 16.) The notification allowed or prompted the
companies to file for the temporary restraining orders.
The Nashville Post reported
that Daniel made the request on
behalf of the fiscal review committee after the state’s finance
department sought to extend the
five-year contract of BlueCross
BlueShield and Cigna by an additional year without going through
a formal bidding process.
While a national debate is
shaping up over transparency
over health-care plan prices for
services, Daniel told the Nashville
Post that he just wants to figure
out what’s going on with the taxpayer-funded state health plan for
employees. “Someone is trying to
hide something here, and we are
going to get to the bottom of it,”
he told the Post.

Companies: Knowledge of
negotiated prices would
promote anticompetitive behavior
The antitrust claim by BlueCross BlueShield and Cigna
argues that the data is “extremely
competitively sensitive, valuable,
confidential, proprietary, and
trade secret information.”
BCBST claims, for example,
that knowledge of such information would “(ii) promote

anticompetitive coordination
amongst BCBST’s actual and potential competitors, (iii) facilitate
anticompetitive coordination by
health-care vendors and providers, and (iv) otherwise destroy
efficiencies in the markets for
health-care products and services
to the detriment of third-party
payors, including the State, other
employer-sponsored group health
plans, and consumers.”
The companies also claim that
Daniel asked for the information
at the behest of companies trying
to interfere with their business.
Daniel told TCOG that he
was seeking the information as
part of his work on the fiscal
review committee, and said he
was concerned about potentially
unreasonably high payments that
could be costing taxpayers in the
millions of dollars. He said he
had initial information showing
a wide variation of costs for the
same procedure but needed more
detail to analyze.

Companies claim
Sherman Act trumps state
open records law
BCBST in its filing said the
Sherman Act and the Fifth
Amendment “trump any claim
of obligation under a state open
records law” and cited a 6th U.S.
Circuit Court of Appeals decision,
United States v. Napier (2000)
ruling that said, “any state law
that conflicts with federal law is
See FISHER Page 12
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When an emergency strikes, dispatchers try to bring calm
ATLANTA NORTHCUTT
Southern Standard, McMinnville
March 17, 2019

When a crisis occurs, the first
number people call is 911. And often they’re screaming and crying.
Warren County Emergency
Communication is the recipient of
the entire county’s landline and
cellphone calls to 911. Dispatchers
work diligently around the clock
to properly handle the situations.
When a 911 call arrives, it’s the
dispatcher’s job to gather correct
information, give proper instructions to the caller, and contact the
safety department most suitable to
deal with the emergency.
“During people’s worst moments, we have to be our best
to provide the highest quality of
assistance,” said Warren County
Emergency Communication director Chuck Haston.
Some calls are ones that will
last forever in the minds of the
dispatcher who received it. After a
tragic suicide that was heard over
the phone, a dispatcher ended his
career. Those are the types of intense situations which could arise
at any time.
There are 14 dispatchers who
work at Warren County Emergency Communication. Typically,
four dispatchers work during the
day and two work throughout the
night. Any call made in Warren
County requesting police, EMS or
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without effect.”
BCBST also attached to its filing
a 2015 letter from the Federal
Trade Commission to the Minnesota House of Representatives
who at the time was involved in
proposed legislation that would
have required public health plans
in that state to disclose information related to price and cost.
In that letter, the FTC said
sharing information such as fees,
discounts and other pricing terms
could lead to sharing information
among competitors and healthcare providers and “facilitate their
ability to coordinate or fi x prices,
allocate markets, or engage in
other conduct that harms competition.”
In that letter, the FTC argues

Photo by Atlanta Northcutt, Southern Standard, McMinnville

E-911 dispatchers Myosha Clark, left, and Jack Godwin work the main command center at Warren County
Emergency Communication.
fire departments is answered by
these dispatchers. These individuals are the lifeline between the
person on the phone and the help
they need.
There’s no difference in the
number of calls received during
the week compared to the weekends, 911 officials say. Often,
warm afternoons during the

spring and fall tend to create a rise
in phone traffic due to increased
activity.
Heeding the old wives’ tale, full
moons often create a surge as well,
Haston said. The highest number
of incidents usually occur from 2
to 11 p.m.
Dispatchers ask many questions
to protect both the callers and

the emergency responders from
dangerous situations. The questions
appear on the dispatcher’s computer
based on the nature of the call. All
dispatchers are trained in Emergency Medical Dispatching on how to
properly handle medical situations.
If a call comes through with no
response on the line, the dispatchers can track the approximate lo-

that providing consumers price
information as proposed by the
legislation would not necessarily
be helpful to consumers in making informed decisions. But even
if there was greater transparency, there was significant risk of
anticompetitive behavior where
health-care providers could know
whether their prices were above
or below others and give them
more leverage in negotiating with
the health plans.
The temporary restraining order
in the BCBST case was granted
without a hearing, although an
undocketed court hearing was held
Monday morning in federal court.
Although Chancellor Lyles
granted a temporary restraining order in the Optum case, a
hearing was scheduled for noon
Tuesday because in that case,

Optum also sued Rep. Daniel in
an individual capacity and it was
unclear if he was notified when
the TRO was being considered.
BCBST is represented by Robert
Boston of Waller Lansden Dortch
& Davis.
Cigna is represented by Erin
Polly and Gibeault C. Creson of
Butler Snow LLP.
Optum is represented by Todd
Presnell, Junaid Odubeko and
Edmund Sauer of Bradley Arant
Boult Cummings LLP.
The state is represented by Janet Kleinfelter, the state’s deputy
attorney general.

CHAVERN

Deborah Fisher is the executive
director of the Tennessee Coalition
for Open Government (TCOG).
This blog was originally posted on
the TCOG website on Dec. 16, 2019.
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their pursuit of the truth.
But news publishers are finding
themselves currently without a
way to recoup their investment
in quality news, which puts the
future of journalism in jeopardy.
The tech platforms currently do not
pay for their use of news content,
making it increasingly difficult for
publishers to reinvest in journalism. The Alliance has called for
news publishers to be granted an
antitrust safe harbor to be able
to come together to negotiate for
better business terms with the
platforms. This is the best solution
to correcting the imbalance in the
digital ecosystem and ensuring a
sustainable future for digital news.
We are encouraged that a bill that
would do just that – the Journalism

cation of the landline or cellphone
to send help. However, the more
information that can be gained
from the caller, the better help that
person can receive. Dispatchers realize each call is different and all
are taken seriously with responders being sent.
The most common law enforcement calls are for domestic
violence or family altercations,
both verbal and physical. The
majority of medical issues are due
to respiratory problems.
With the opiate crisis increasing, more drug-related calls are
being made to 911. Police aren’t
sent for everything, but if the
caller has attempted previous
dangerous actions toward medical
responders or has a history of
violence, police will be sent for
protection.
“We have an equal responsibility to the caller, the community
and also those responders who
are going to go to a location with
limited information,” said Haston.
“You have to be so careful to ensure everyone’s safety.”
Not all calls are traumatic
or troublesome. Some positive
moments, such as a baby being
born, bring light to the dispatcher
on the other end of the line. Staff
members are close and continuously support each other due to
the experiences only they have
endured and understand.
Competition & Preservation Act –
was introduced in the House and
the Senate earlier this year.
News media have made our
democracy stronger, our citizenry
more informed and engaged, and
our Constitutional rights secure
and strong. As we marked National Newspaper Week, we asked that
anyone who relies on news for
their information — whether in
print or online — to ask Congress
to support the Journalism Competition and Preservation Act.
David Chavern serves as President & CEO of the News Media
Alliance. Chavern has built a career
spanning 30 years in executive
strategic and operational roles,
and most recently completed a
decade-long tenure at the United
States Chamber of Commerce.

